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Overview of Q-Box NF1LP Nitrogen Fixation Package: 

The Q-Box NF1LP Nitrogen Fixation Package provides the only safe and inexpensive means to study 

Nitrogen Fixation in legume plants that evolve H2 gas as a by-product of the nitrogenase enzyme activity.  

Traditionally, “N2 Fixation” has been measured by the acetylene reduction assay, which requires the use 

of a gas chromatograph to measure the reduction of acetylene to ethylene by N2 fixing organisms. Gas 

chromatographs are expensive and the 10% acetylene required for the assay is explosive.  In addition, it 

has been shown that the acetylene reduction assay inhibits the nitrogenase reaction!  The use of Q-Box 

NF1LP Nitrogen Fixation package avoids these complications and provides an accurate and inexpensive 

way of measuring nitrogen fixation as a H2 evolution rate in real time. 

The Q-Box NF1LP Nitrogen Fixation Package can only be used with legume symbioses that lack the enzyme 

Uptake Hydrogenase (HUP).  This enzyme oxidizes H2, and prevents its release from nodules where the N2 

fixing bacteria reside.  The Q-Box NF1LP package includes soybean seeds (Glycine max) and a peat-based 

inoculant of Bradyrhizobium japonicum strain 532c (Becker Underwood Inc.) which, when used according 

to the plant cultivation section in this chapter, will produce H2-evolving legumes within a 28 day period.  

Other legumes may be used with the N2 Fixation package, but they should be inoculated with the correct 

(Brady-) Rhizobium strain lacking the HUP enzyme, so that H2 gas is evolved from the nodules during the 

process of N2 fixation. 

The Q-Box NF1LP Nitrogen Fixation Package provides all the equipment required to set up an open flow 

gas exchange system.  Gas is supplied to the pot with the plant from a gas bag via a Q-G268 Flow Monitor 

and Pump.  Gas is sub-sampled at a lower flow rate from the growth pot with the plant via a Q-G267 Flow 

Monitor and Pump and delivered to the Q-S121 H2 Analyzer.  From the H2 Analyzer, gas enters the Q-S102 

O2 Analyzer and then vents to the atmosphere.  The analog signals from the Flow Monitors, the H2 and O2 

analyzers plus a temperature probe (S132) that can be inserted in the plant pot, are converted to digital 

signals via three integrated interfaces (9 available channels).  Data are displayed, recorded and 

manipulated on a PC or Macintosh computer using Logger Pro software. Changes in the concentrations of 

H2 and O2 plus temperature of the growth medium can be monitored in real time.   

The Q-Box NF1LP Package also contains 4 gas exchange pots for the cultivation of the plants.  The plants 

must be cultivated in the correct planting medium to allow gases to flow from the nodulated roots to the 

H2 Analyzer.  We recommend silica sand as an ideal medium, since it has the correct porosity, and contains 

no nitrogenous matter that may inhibit N2 fixation.  Silica sand is otherwise known as industrial quartz 

(Unimin Corp., phone 203-966-8880).  Size 3.0 (sandblasting equivalent) mesh should be used, the 

effective grain size of the sand being 0.65 mm.   Soil should not be used, as this may contain micro-

organisms that possess the HUP enzyme and re-oxidize the H2 released from the nodules.  Also, most soils 

are too dense to allow proper movement of gases from the nodules to the analyzer. 

Included in the Q-Box NF1LP package is a flow through chamber for measurements of detached nodules.  

The package can also be used for measurements of H2 production or consumption in the range of 0-

100ppm of any soil or bacterial samples.  Contact Qubit for other flow through chambers of various sizes 

and for various applications. 
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It is recommended to read the section “General Introduction to Nitrogen Fixation” of this manual (page 

22) before using the Q-Box NF1LP. 

 

Components of Q-Box NF1LP: 

Q-G268 Flow Monitor and Pump (0-2L/min) 

Q-G267 Flow Monitor and Pump (0-1L/min) 

Q-S121 H2 Analyzer (range:  0-100ppm) 

Q-S102 O2 Analyzer compensated in the software for pressure changes (Range:  0-25% and 0-100%) 

Drying column for Q-S121 and S102 with Drierite (blue) (2x) (Q11784) 

G113 Flow-through Chamber (1.6 cm ID x 10 cm L) 

S132 Stainless Steel Temperature Probe 

C301 Event Switch (for marking in the software change from air to Ar:O2 gas) 

G122 Large Gas Bag (30 Litres x 2) 

G132 Plant Growth and Gas Exchange Pots with connectors, stopper, lid and sealant (4x) 

B201 Soybean Seeds and Bradyrhizobium japonicum innoculant 

Integrated Data Acquisition Interface C610 LabQuest Mini x3 

C901 Logger Pro Data Acquisition Software 

C404 Customized Setup Software 

Q-Box Accessory Kit (includes tubing, filters, luer connectors and T-pieces, wool, wrench for needle valve 

adjustment, qubitac sealant, screwdriver for calibration of analyzers, 2 x 3-way valves for gas bypass of 

the pot during reference measurement) 

Manual 

Individual power supplies for all the sensors (for use in stand-alone mode) 

Rugged weather proof case 
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Quick Start Up Steps: 

1. Load Logger Pro 3 software onto the computer (follow instructions on page 26).   
2. Load C404 customized software (follow instructions from page 28) 
3. Plug the Q-Box into a power supply  
4. Turn on the Q-G268, Q-G267, Q-S121 and Q-S102  
5. Allow the Q-S121 H2 analyzer to warm up for at least 1hr with air flowing past it to obtain stable 

and accurate readings. 
6. Connect three USB cables from the Q-Box frame to the computer directly (A USB hub may be 

required if 3 USB ports are not available on the computer) (may hear 3 audible sounds as the three 
interfaces are recognized and drivers are loaded).  Connect USB1 first and then USB2 followed 
by USB3. 

7. Open the “Q-Box NF1LP Setup” file to start Logger Pro software.  The following sensor 
confirmation window will be visible.  

 

8. Assign the undetected sensors to appropriate channels on the 2 interfaces by selecting the sensor 
and clicking “connect” button as follows: 

a. Ch. 1 LabQuest Mini 1 = Raw Voltage (Q-S121 H2 Analyzer) 
b. Ch. 2 LabQuest Mini 1 = Raw Voltage (0-5V) (C301 Event switch) 
c. Ch. 1 LabQuest Mini 2 = Q-S102 O2 Sensor (O2) 
d. Ch. 2 LabQuest Mini 2  = Q-G268 Pump Flow Monitor (V) 
e. Ch. 3 LabQuest Mini 2  = Q-G267 Pump Flow Monitor (V) 
f. Ch. 1 LabQuest Mini 3 = Q-S102 Analyzer Pressure 

Note Ch. 3 LabQuest Mini 1 automatically recognizes the S132 Stainless Steel Temperature 
Sensor and places it in active sensors list. 
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The list of the sensors and their connections is included in a window on Page 1 of the Q-Box 
NF1LP Setup file for easy reference and is shown below. 

 

 

9. Check and set up the plumbing of the system by gently removing the tray with all the sensors from 
the Q-Box and placing it outside of the box with the back of the sensors facing up.   The system 
should be configured for calibration before it is used in experiments. 
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Component Set-Up for Calibration (reference mode) 

 

 

 

 

 

 

 

 

a. The gas supply tubing from the gas source bag or other constant source of H2 is attached 

to “PUMP IN” port on the Q-G268 Flow Monitor and Pump via a blue particle filter (25m).  
b. Short tubing from “PUMP OUT” port of the Q-G268 goes to “FLOW IN” port of the Q-

G268.   
c. Tubing from “FLOW OUT” port of the Q-G268 initially (reference mode) should go to 

“PUMP IN” port of the Q-G267 Flow Monitor and Pump via a T-Piece.  The T-piece allows 
the extra reference gas to vent while Q-G267 Flow Monitor and Pump subsample this gas 
at a lower flow rate (suggest 100ml/min) than that of Q-G268 for supply to the gas 
analyzers.   
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d. Short tubing from “PUMP OUT” port of Q-G267 is connected to “FLOW IN” port of the Q-G267 
and the tubing from “FLOW OUT” port is connected via a drierite column and a blue filter to 
the “GAS IN” port of the Q-S121 H2 Analyzer. 

e. (Note that only one drying column needs to be used when QS121 and QS102 are used in 
series.  Gas should be well dried before entering the H2 analyzer.   A second drying column is 
provided for stand-alone use of the Q-S102 or for quick change when first one is spent) 

f. From “GAS OUT” port of the Q-S121 H2 Analyzer, short tubing attaches to “GAS IN” port of 
the Q-S102 O2 Analyzer. 

g. Gas vents from the O2 analyzer via the “GAS OUT” port.   
h. Three particulate filters (blue) should be placed in the gas line, one before each “PUMP IN” 

port of Q-G268 and Q-G267 and one before the inlet into the H2 analyzer to prevent 
particulate matter from entering the system or the analyzers. 

 

10.  After initial calibration and a check of the system, configure the Q-Box for measurements of 
Hydrogen evolution from the plant pot in an open-flow system: 

 

Component Set-Up for Sample Measurements in Open-Flow System  

 

 

 

 

 

a. Maintain all connections as in the reference mode except the tubing from “FLOW OUT” port 
of the Q-G268 should be connected to the gas inlet at the bottom of the sealed plant pot (See 
instructions on how to seal the plant pot for gas exchange measurements on page 16).   

b. Attach the tubing from the lid of the pot (gas outlet of the pot) to the “PUMP IN” port of the 
Q-G267 via a T-Piece.  The blue filter should be placed right in front of the “PUMP IN” port of 
the Q-G267 to prevent any sand particles from the pot entering the system.  The T-piece will 
allow the excess gas from the pot to vent to the atmosphere while the gas pump of the Q-
G267 sub-samples the gas and delivers it to the Flow Monitor of the Q-G267 and the 
analyzers.  

c. The rest of the connections remain as described for the reference mode above.  
d. Note that the blue particulate filters should be checked regularly and cleaned or replaced as 

they may get clogged over time. 
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Note: The manual 3-way valves are installed as in the above diagram to direct the flow of 
gas either through the pot to obtain a measurement, or to bypass the pot to obtain 
reference levels measurements.  

 

 

11. Set the flow rate through the system.  Open the “Q-Box NF1LP Setup” file so the Q-G268 and Q-
G267 meters are active and visible (see image below). 

 

Please ensure that the event switch Is set in the correct position (Air at the start of the experiment) 
as the Flow rate displayed in the meters is corrected for the background gas.  Set the flow of gas 
to the plant pot with the Pump of the Q-G268. This flow rate depends on the H2 evolution rates 
of the plant and initially may be set around 200ml/min. Once the H2 evolution rate is detected, 
this flow may be adjusted accordingly to either increase or decrease the H2 signal.  When the flow 
through the pot is set, then the flow rate of the sub-sampling pump of the Q-G267 is set and it 
should be less than the flow through the pot (i.e. if the flow through the pot is 200ml/min, the 
flow to the analyzers could be 100ml/min).  The excess gas will vent through the T-piece placed 
before the Q-G267.   The flow rates of gas entering the Q-S121 and Q-S102 analyzers should be at 
least 5-10ml/min and should not exceed 650ml/min and it should be maintained constant through 
the experiment.   

The flow rate of the pumps in both Q-G268 and Q-G267 is set using the two needle valves on the 
back of the instrument.  It is recommended to use the valve across the “IN” ports first to bring the 
flow half way to the desired value (as displayed in Logger Pro) and use needle valve across the 
“OUT” ports to adjust the flow down to the final rate.  Turning the valves counter clockwise 

Valves deactivated-gas 

supplied to sample 

Valves activated-gas 

bypassing sample 
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increases the flow and clockwise reduces it.  Once the flow is adjusted to the desired rate, use the 
small wrench provided in the accessory pack to lock the valves in place to avoid accidental changes 
in the flow rate during experiments.  Note that flow rate is recorded in software, so any changes 
will be recorded.  The tray holding all the sensors can then be placed back in the Q-Box. 

 

12. The Q-G268 and Q-G267 Flow Monitors plus S132 Temperature Sensor are factory calibrated and 
no additional calibrations are required.  The Q-S121 H2 Analyzer and Q-S102 O2 Analyzer have also 
been factory calibrated but should be checked at the start of each day of experiments and 
recalibrated or adjusted if necessary.  The Q-S102 Oxygen Analyzer requires only 2 point 
calibration as its output is linear.  The first point should be zero (i.e. N2) and the second point 
should be a standard O2 concentration within the range at which the analyzer will be used.  The 
Q-S121 H2 Analyzer has a non-linear output and the factory calibration employs a 5th level 
polynomial equation that has been incorporated into the software.  The response of the Q-S121 
H2 analyzer is affected by the background gas, oxygen concentration and to a lesser degree, the 
flow rate past the analyzer.  The Q-Box NF1LP Package has been designed for use at Air levels of 
oxygen concentration (21%).  The software corrects the response of the analyzer for changes in 
the background gas from air to Ar:O2 mixture (at 21% O2) if the event switch C301 is correctly set 
(see instructions below on page 11).   For optimal results the calibration check of the H2 analyzer 
should be done daily in air or a N2:O2 79:21 mixture. Also small adjustments of the “H2 zero” and 
“H2 Span” should be done as part of the daily calibration check that involves 2 points, zero and a 
known H2 standard within the range of 0-100ppm.  If the H2 Analyzer is to be used at O2 
concentrations different from 21% a custom calibration of the analyzer needs to be performed at 
each of the O2 concentrations and the polynomial equation for each of the O2 concentrations 
needs to be incorporated into the software.  This is beyond the scope of this package. Contact 
Qubit Systems for information on the components required for custom calibration at different O2 
levels.  
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13.  Calibration check of  the Q-S121 H2 Analyzer (two point calibration): 

 

a. The Q-S121 H2 analyzer should be plugged in and warmed up with air flowing past the 
sensor for at least an hour before use.  The calibration check should be done in Air and at 
the flow rate past the H2 analyzer as set with the Q-G267 that will be used in the 
experiment.  The response of the H2 Analyzer is optimized by a brief initial exposure to 
high H2 concentration (0.5 to 1% H2 is ideal to prime the sensor but if only calibration gas 
such as 100ppm is available it will be sufficient). It is therefore recommended to flush the 
H2 sensor with high H2 concentration for a couple of minutes before proceeding with the 
calibration. 

b. Ensure that the Logger Pro software is running during the calibration check.  Open the “Q-
Box NF1LP Setup” file and after sensor selection as described above on pg. 5and  proceed 
with calibration. 

 

c. Once the sensor has been warmed up and primed, supply H2 free –air to the analyzer by 
attaching the bag with zero H2 gas to the “PUMP IN” port of the Q-G268.  Note that room 
air levels of H2 gas are not zero. Observe in the Logger Pro software on Page 1 of the “Q-
Box NF1LP Setup” file the H2 ppm signal (shown in the meter, left hand bottom corner).  
H2 ppm signal is the signal corrected for the background gas (either air, which is 79% N2 
and 21%O2, or Ar:O2 (79:21) mixture) as long as the C301 Event switch is in correct 
position.  Note that the C301 switch has to be set manually by the user according to 
what background gas is being used.  When the switch is in Air or Ar position the software 
will apply the correct calibration to H2 signal and correct H2 levels will be displayed in the 
“H2 (cor) ppm” meter or in the Hydrogen (ppm) graph.  When Air is selected, the “Air/Ar 
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Switch” in software (left hand bottom corner) will display 0.  When Ar is selected 1 will be 
displayed.  (See page 31 for more details).  If the H2 ppm reading is 0.0 (+/-0.1) no 
adjustments are needed to the H2 Analyzer at this point.   

 

d. If the H2 ppm reading in the software is different from 0.0 use the “H2 Zero” 
potentiometer on the front of the Q-S121 H2 Analyzer to bring the reading to 0.0.  Turning 
the potentiometer clockwise with the small green screwdriver provided will increase the 
signal and counter clockwise it will decrease the signal. 

 

 

e. Once the Zero H2 has been established (about 5 min), proceed to the second point in the 
calibration check.  Attach a gas bag with a known H2 concentration, for example 100ppm 
(and the same background gas) in the expected range to be measured to the “PUMP IN” 
port of the Q-G268.   
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f. Wait until the H2 ppm reading in the software becomes stable (about 5 min).  If the 
reading in the software matches the H2 concentration of the standard gas, no further 
action is required.  If the reading in the software is different, use the “H2 Span” 
potentiometer control on the front of the instrument to adjust the reading in the software 
to that of the standard gas.  Use the green screwdriver provided to adjust the “H2 Span” 
potentiometer clockwise to increase the signal and counter clockwise to decrease the 
signal. 

g. If adjustment to the “H2 Span” was made, it is advisable to go back to the zero H2 check 
and make sure that the zero reading on the analyzer has not shifted.   

h. The H2 Analyzer is now ready for measurements.  It is advisable to keep the H2 analyzer 
powered continuously if used regularly so it stays warmed up and maintains its 
calibration. 

Please note that if the H2 analyzer will be used at other O2 concentrations than 21% then a 
full calibration of the analyzer needs to be done at that O2 concentration.  A gas mixing system 
will be required for such a calibration or precise calibrated gas pumps like wosthoff pumps 
will be required to provide a whole range of H2 concentrations at that O2 level. 

14. Calibration and check of the Q-S102 O2 analyzer (2 point calibration): 

Note the Q-S102 analyzer measures partial pressure (kPa) of O2 in a gas, not concentration (%) 
of O2 in the gas.  Only at a pressure of exactly 100kPa does the O2 partial pressure correspond to 
% O2.  The partial pressure of O2 will follow atmospheric pressure changes whereas the 
concentration is constant and independent of pressure variation. The O2 analyzer also measures 
total gas pressure in the system. Correction of the O2 signal for pressure changes is done in 
software according to changes in total gas pressure to produce O2(Pcor) reading in % units.  These 
corrected readings (see calculation below) are displayed in the software in a meter and in the 
graph.  

O2 (Pcor) = ((Q-S102 O2 )/(Patm))*100 

Q-S102 O2 is the recorded O2 partial pressure, and Patm is the (total) gas pressure (i.e. atmospheric 
pressure) as measured by the pressure sensor of the Q-S102 O2 analyzer.  

15. To check and adjust the calibration of the Q-S102 follow these steps: 
a. Set the Q-S102 O2 analyzer in the 25% range (the default range for measurements with 

this package). 
b. In the software select from top menu Experiment>Calibrate>LabQuest Mini 2 Ch1>Q-

S102 O2 Analyzer (25KPa)  
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c. Supply O2 free – gas (i.e. N2 gas) to the analyzer by attaching the O2-free gas source (gas 
bag) to the “PUMP IN” port of the Q-G268.  As the O2-free gas enters the Q-S102 O2 
Analyzer, the reading in the software on Page 1 - O2 (Pcor) will decrease toward zero (the 
first point of the calibration) 

 

 

 

d. When the reading in the software, O2 (Pcor), stabilizes, use the small green screwdriver 
provided to adjust the “O2 Zero” potentiometer on the Q-S102 O2 analyzer to set O2 
(Pcor) in the software to read 0.0 %.   

e. Once the zero O2 is established, proceed to the second point in calibration.  Attach the 
gas bag with known O2 concentration or a dry room air source (contains 20.95% O2) to 
the “PUMP IN” port of the Q-G268. 
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f. When the O2 (Pcor) reading in software stabilizes, adjust the “O2 Span” control on the Q-
S102 O2 analyzer until the reading of O2 (Pcor) in the software corresponds to the O2 
concentration supplied to the analyzer. 

g.  If a significant adjustment had to be made to “O2 Span”, it is advisable to go back to the 
zero check and make sure that the zero reading on the analyzer has not shifted.  It is not 
necessary to do the zero check while in the calibration mode of the software. 

 

16.  The Q-Box NF1LP system is now ready for use with the plant or a flow through chamber 
containing detached nodules or other H2 evolving samples.  See instructions below on preparing 
the plant pot for root gas exchange measurements. 

 

17.  For detached nodule gas exchange measurements, assemble the flow through chamber by 
placing the temperature probe in the opening of one of the end caps as shown.  If the temperature 
probe requires additional sealing around the opening, use the blue Qubitac sealant provided in 
the Q-Box accessory kit.   

 

 

18.  Place the nodules in the chamber and attach the chamber to the system in place of the plant pot 
as shown in item #10 above for an Open-Flow system. Placing the nodules on a moist tissue paper 
will prevent them from drying out. 

 

19. Preparing the Plant For the Gas Exchange Measurements: 

The pots supplied with the Q-Box NF1LP Nitrogen Fixation Package are ideal for the growth of 
soybeans and other legumes (beans, peas, lupins etc.) for use in gas exchange experiments.  
Additional pots may be purchased from Qubit Systems. Plants need to be grown in an inert 
medium such as silica sand for best results in gas exchange experiments. See the included 
instructions for cultivation of plants for gas exchange.  It is important that the root system is 
sealed well in the pot for gas exchange measurements. 
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The base of the pot contains two inlet holes.  One hole is used to attach the tubing from the Q-

G268 Flow Monitor and Pump (via the use of a hollowed stopper fitting). The drainage hole on 

the other side of the pot should be plugged with a rubber stopper.  The lid of the pot has a slot to 

accommodate the stem of the plant and the temperature probe (S132).  The outlet hole in the lid 

attaches, via tubing and the T-Piece assembly to the “PUMP IN” port of the Q-G267 Flow Monitor 

and Pump.  Before placing the lid over the pot, ensure that the edge of the lid is lined with a thin 

layer of the blue Qubitac sealant, so when it is pressed against the edge of the pot a gas tight seal 

will be formed. 

 

The lid snaps down to seal around the perimeter of the pot while the stem of the plant and the 

temperature probe are positioned in the slit of the lid.  The slit in the lid must then be sealed 

from the outside with the blue Qubitac sealant to render it gas-tight.  Seal the slit by placing a 

long piece of Qubitac around the plant stem and over the perimeter of the slit and press the 

Quibitac together and gently down against the lid to seal the plant in the pot. 
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 Ensure that the Qubitac is tight around the stem so no gas leaks are formed.  Once the gas is 

being supplied to the pot through the bottom gas inlet, check that gas is coming out of the pot 

through the gas outlet in the lid.  When the T-piece is attached to the gas outlet from the lid and 

the “PUMP IN” port on the Q-G267, check that excess gas is venting through the T-piece outlet. 

IT IS EXTREMELY IMPORTANT TO PROPERLY SEAL THE POT TO PREVENT LEAKS 

Note that the blue Qubitac sealant can be reused many times after some cleaning and stretching 
to remove sand particles from previous use. 

20. Before starting to collect data with Logger Pro software, select Experiment > Data Collection in 
the main menu or click on the clock icon.  The following dialog box will appear: 

 

Input experiment length and data sampling rate as required.  The default rate is 60 samples per 
minute.  Click “Done”. 

Select: File> Save As to save the experiment settings under a new File Name so that the original 
set up file (Q-Box NF1LP Setup) is not over- written.  

  Start data collection by clicking the green button “Collect” 
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21.  Stop data collection by clicking the red button “Stop” (“collect” button turns into “stop” button 

during data collection), 

 

22. Logger Pro software displays data on Page 1 “Raw Data” as they are collected in graphs, meters 

and spreadsheet columns.  Sample data are shown below  

 

 

 

 

 

23. During the experiment, the x and y axis ranges can be adjusted by clicking on the lowest or highest 

number and typing in the desired new value. 
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24.  Upon completion of the experiment, the data can be analyzed directly in Logger Pro using the 

various analysis tools in the Analyze menu, or using icons selected in the top menu bar.  Further 

calculations can be done directly in Logger Pro on Page 2 called “Calculations”.  The data can also 

be directly exported as a text file (File > Export As > CSV), which can then be opened in Excel for 

further analysis and calculations. 

 

 

 

Calculations of Nitrogenase Activity and Nitrogen Fixation rates  

 

To fully understand the calculations, read page 22, “General Introduction to Nitrogen Fixation”.   

Upon completion of an experiment, the raw data can be analyzed on Page 2 of the Q-Box NF1LP Setup file 

– “Calculations”.  On this page data can be entered in the columns highlighted in red, and calculations are 

done automatically in the black columns.   
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H2(cor) Ref in Air is the value of corrected H2 signal in ppm measured in Air during a reference run (no 

pot attached to the gas exchange system or 3-way valves set to bypass the pot).  H2(cor) Sample in Air is 

the corrected H2 signal in ppm with the plant attached to the system.  The difference between these two 

values equals the H2 evolved by the root system of the plant in Air.  Q-G268 Flow (Air) is the flow rate 

through the pot in ml/min during ANA measurement (in air) and Q-G268 Flow (Ar) is the flow rate through 

the pot in ml/min during TNA measurement (in Ar:O2).  Please note that there is a small change in the 

flow rate when background gas is changed from Air to Ar:O2.  The software corrects for this change and 

displayed corrected flow rates for the both Q-G268 and Q-G267 Flow monitors when the even switch is 

depressed correctly.  DWnod is the dry weight of the nodules (detached after the completion of the 

experiment and oven dried).  The software calculates the value of ANA or the Apparent Nitrogenase 

Activity in mol/hr/gDWnod.  Values of H2(cor) Sample in Ar:O2 and H2(cor) Ref in Ar:O2 are the 

corrected H2 signal in ppm during the exposure of the root system to Ar:O2 and the reference reading in 

Ar:O2 without the plant in line (or pot bypassed by 3-way valves), respectively.  These values are used in 

calculation of Total Nitrogenase Activity (TNA) by the software.  From ANA and TNA, values the software 

calculates the rate of Nitrogen Fixation and the Electron Allocation Coefficient (EAC) according to the 

following equations: 
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To obtain the raw data for the calculations of ANA and TNA, numerous data analysis tools of Logger Pro 

can be used.  These are displayed in the top menu as individual icons.  Data can be selected on each graph 

by dragging the mouse over the portion of interest on that graph.  When the data have been selected, the 

appropriate analysis tool can be chosen i.e. Statistics function to obtain mean or average data over a 

period of stable readings (see example below). 

 

 
 

The statistics will then be shown in a separate window for the selected data on each of the graphs.  The 

display of the values in the analysis window can be adjusted in the options window by right clicking on the 

statistics window and selecting the number of decimal spaces to be displayed. 
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The mean values for each of the parameters can then be copied from the stats windows into the 

calculation page in the appropriate red columns.  This has to be done manually by the user.  Once the 

red columns with the input parameters are filled, the calculation columns (black) will fill automatically 

with the calculated values. 

General Introduction to Nitrogen Fixation 

Biological N2 fixation is a process of fundamental importance to life on earth.  Annually, 200 million tons 

of nitrogen is added to the soil by nitrogen fixing organisms - 4 times the amount provided by inorganic 

fertilizers.  Most of the nitrogen entering the environment by fixation is derived from bacteria that form 

symbiotic associations with certain plants. It has been known for centuries that these plants (especially 

legumes such as clover and alfalfa) improve the yield of other crops when they are grown with them in 

rotation.   

Biological N2 fixation in leguminous plants requires the development of a symbiotic relationship between 

soil bacteria and the plant root.  The most common endosymbionts found in the roots of crop legumes 

are bacteria of the genera Rhizobium and Bradyrhizobium.  An extremely complex recognition process has 

evolved between the plant and bacteria, so that the interactions between the plant and the bacteria are 

species specific.  The Q-Box NF1LP Nitrogen Fixation Package includes soybean seeds and Bradyrhizobium 

japonicum inoculants for studies of N2 fixation and nitrogenase activity in this Soybean x Bradyrhizobium 

symbiosis. 

As in all legume symbioses, B. japonicum inhabits swollen outgrowths of the soybean root called nodules.  

The root nodule can be subdivided into specific zones.  The outer periderm consists of loosely packed cells 

and lenticels through which gases diffuse into the outer cortical layer.  These gases include the N2 required 

for N2 fixation, as well as O2 required for plant and bacterial respiration.  The cells of the outer cortex are 

also loosely packed, and contain large air spaces, which offer little resistance to the diffusion of gases.  

However, in the inner cortex, the cells are smaller and much closer together, and here the gases may have 

to diffuse through the contents of the cortical cells to reach the central zone of the nodule, since open 

intercellular spaces are infrequent.  This part of the nodule is thought to act as a barrier to gas diffusion.  

The central zone of the nodule contains plant cells that are infected with thousands of bacteria.  In their 

symbiotic form, these bacteria are called bacteroids, and a typical soybean root may provide a home for 

2,000,000,000 of these bacteroids. 

The bacteroids are responsible for reducing the N2 gas that diffuses into the central zone to ammonia, 

which can then be assimilated by the plant cells.  The diagram below shows the exchange of materials 

that must occur between the plant and the bacteroids to allow for the fixation of N2 and the assimilation 

of ammonia. A carbon source from the plant is supplied via the phloem to root nodules housing the N2 

fixing bacteria.  The carbon source is partially metabolized by the plant and the resulting carbon 

compounds are imported into the bacteria.  The bacteria contain the enzyme nitrogenase, which is 

responsible for catalyzing the reduction of N2 gas to ammonia.   

The carbon compounds entering the bacteria are metabolized to produce the ATP and reductant required 

in the nitrogenase reaction.  The ammonia produced in the reaction is transported to the plant where it 
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is assimilated into organic nitrogenous compounds.  These are exported in the xylem to the rest of the 

plant where they are used in the synthesis of amino acids, nucleic acids and other nitrogen-containing 

compounds.  

 

N 2   +  8H +   +  8e-  +  16ATP H 2   +  2NH 3   +  16ADP  +  16Pi 

Bacterial metabolism 

  Carbon compounds 
   passed to bacteria 

Sugars partially metabolized 
by plant 

Sugars transported to nodule 
in phloem 

Gas lost to soil 

Ammonia passed to plant 

Ammonia assimilated into 
amino acids etc. 

End-products of N 2  fixation 
exported in the xylem 

Nitrogenase 

 

 

Measurement of Nitrogenase Activity 

Nitrogenase is a promiscuous enzyme that is capable of reducing a wide range of substrates.  The 

traditional method of assaying nitrogenase activity is by the acetylene reduction assay, in which nodulated 

roots are supplied with 10% acetylene.  This gas is reduced by nitrogenase to ethylene, and the amount 

of ethylene produced per unit of time is measured by gas chromatography.  This assay is dangerous to 

perform, since 10% acetylene is explosive, and it uses a non-physiological substrate for the nitrogenase 

reaction.  A better assay is to measure the H2 that is produced as an obligate by-product of the N2 fixation 

reaction: 

 

Pi) (ADP 16   H    2NH    16ATP    8e    8H    N 23
-

2
eNitrogenas +++⎯⎯⎯⎯ →⎯+++ +

 

Many Rhizobium and Bradyrhizobium species possess an enzyme called uptake hydrogenase (HUP), which 

re-oxidizes the H2 produced in the nitrogenase reaction.  However, a great many other Rhizobium and 
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Bradyrhizobium species lack this enzyme, and the H2 produced within the nodule diffuses out into the soil.  

The Q-Box NF1LP package includes the inoculum (black powder) with a bacterial species (B. japonicum) 

that lacks HUP and therefore evolves H2.  The rate of H2 evolution from the nodules provides a 

measurement of nitrogenase activity.  The great advantage of measuring nitrogenase activity by H2 

evolution, is that measurements can be made with minimal disturbance of the plant tissue.   

Measurement of H2 production from nodules provides only a measurement of Apparent Nitrogenase 

Activity (ANA).  This is because of the 8 electrons passing through nitrogenase in the reaction shown 

above, a minimum of 2 of these are used to produce H2, while the others are used in the reduction of N2 

to ammonia (NH3).  H2 production rate provides only a measurement of that proportion of the enzyme 

activity that is being used to reduce protons, and while this must represent at least 25% of the total 

enzyme activity, the allocation of electrons between N2 and H+ reduction is variable.  To measure Total 

Nitrogenase Activity (TNA), it is necessary to replace the N2 in the atmosphere surrounding the nodule 

with an inert gas such as Ar.  When this is done, all the electrons that were previously allocated to N2 

reduction are used for H+ reduction and the rate of H2 evolution from the nodule increases rapidly.  The 

maximum rate of H2 evolution from the nodule after a switch from a N2:O2 atmosphere to an Ar:O2 

atmosphere represents TNA.  To determine the rate of N2 fixation that was occurring under initial 

conditions the following equation is used: 

( )
3

 ANA-TNA 
    Rate Fixation N2 =  

A denominator of 3 is used because reduction of N2 to NH3 requires 3 electron pairs, whereas reduction 

of H+ to H2 requires only 1 electron pair.   

As stated above, in air at least 25% of total electron flux through nitrogenase is used for H+ reduction but 

this value is not constant, and often more than 25% of electron flux through nitrogenase is "wasted" in H2 

production.  To determine the relative allocation of electrons between H+ and N2, the Electron Allocation 

Coefficient of nitrogenase (EAC) may be calculated: 








=
TNA

ANA
  -  1    EAC  

EAC is an important parameter, because higher values of EAC indicate that a greater proportion of 

nitrogenase activity is being used for the production of nitrogenous products for export to the plant. 

 

The Regulation of Nitrogenase Activity 

The nitrogenase reaction requires a great deal of energy, consuming at least 16 ATP and 4 pairs of 

electrons for every molecule of N2 reduced to ammonia.  This energy is derived from carbohydrates 

provided by the plant, and nitrogenase activity therefore represents a drain on the plant's resources.  To 

ensure that nitrogenase functions with benefit, rather than detriment to the plant, regulatory 
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mechanisms have evolved to reduce, or to halt, nitrogenase activity when the plant is supplied with an 

adequate source of combined nitrogen.  Since carbohydrate supply to the nodule is essential to sustain 

nitrogenase activity, it is no surprise that any factor, which limits phloem sap supply to the nodule, also 

causes nitrogenase inhibition.  However, the mechanisms by which nitrogenase is inhibited by phloem sap 

deprivation, or by combined nitrogen, are complex and require an understanding of the regulation of 

respiratory processes in the nodule as outlined below. 

Nitrogenase Activity and Oxygen 

The nitrogenase enzyme is peculiar in that to function, it requires ATP derived from oxidative 

phosphorylation, yet at the same time it is extremely O2-labile.  Therefore, the nodule must have 

mechanisms for delivering a high flux of O2 to support respiration in the infected cells, while maintaining 

the free O2 concentration in these cells at an extremely low level.  It has been estimated that the O2 

concentration in the infected cells of the nodule may be as low as 30 nM, compared to an O2 concentration 

of 250 000 nM in the cells of the nodule outer cortex.  This low O2 concentration in the infected cells is 

maintained by a barrier to O2 diffusion in the nodule inner cortex, which severely limits the diffusion rate 

of O2 to the central zone.  Also, the high rate of bacteroid respiration ensures that the O2 diffusing into 

the central zone is consumed swiftly and does not accumulate.  In fact, the O2 concentration in the 

infected cells is so low that O2 cannot diffuse fast enough by itself to support the demands of bacteroid 

respiration.  To alleviate this limitation, the infected cells contain a red pigmented protein called 

leghemoglobin, which acts as an O2 carrier, and facilitates the diffusion of O2 to the bacteroids.  In both 

its structure and its function, leghemoglobin is very similar to myoglobin in human blood, and it is an 

example of how plants and animals have evolved similar mechanisms to cope with similar problems.  The 

leghemoglobin in nodules is easily visible, and its red colour clearly delineates the central zone of the 

nodule from other nodule tissues.   

Regulation of the O2 Diffusion Barrier 

It has been shown that the barrier to O2 diffusion in the legume nodule does not have a fixed resistance, 

but can vary the degree to which it limits O2 diffusion into the central zone.  If the nodulated root is placed 

in a low O2 environment, the diffusion barrier relaxes its resistance to maintain an adequate flux of O2 to 

the infected cells.  Conversely, when the nodulated root is placed in a high O2 environment, the diffusion 

barrier increases its resistance to prevent too much O2 entering the infected cells and causing nitrogenase 

inhibition.  Although low O2 environments are common in nature (such as in waterlogged soils), 

environments containing supra-ambient levels of O2 are extremely rare.  However, the ability of the 

nodule to respond to high levels of O2 in the infected cells is very important, since any process which limits 

the respiration rate of these cells will reduce the rate at which O2 is consumed and cause O2 to accumulate.  

Therefore, under these circumstances the nodule increases its resistance to O2 diffusion to reduce the flux 

of O2 to the central zone.  It is this increase in diffusion barrier resistance that is mostly responsible for 

the inhibition of nitrogenase activity that occurs when nodules are supplied with combined nitrogen, or 

are deprived of phloem sap. 
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When combined nitrogen is supplied to the nodulated root, continued nitrogenase activity would 

represent a waste of the plant's carbohydrate resources.  Therefore, a signal is given to the nodule to 

increase its resistance to O2 diffusion.  This causes a reduction in the rate of infected cell respiration, and 

insufficient ATP and reductant are generated for the nitrogenase reaction to continue at a high rate.  

When the supply of phloem sap to the nodule is prevented (e.g. by severing the plant shoot (de-topping), 

or removing its leaves (defoliation), or by picking the nodules off the plant), the reduced amount of 

carbohydrate entering the nodule could eventually lead to a reduction in infected cell respiration and a 

consequent increase in infected cell O2 concentration.  Therefore, a signal is given to the nodule to 

increase its resistance to O2 diffusion.  This has the combined effect of limiting O2 entry into the central 

zone (thereby protecting nitrogenase from inactivation) and of reducing respiration rate (thereby 

conserving carbohydrates that may eventually become scarce).  The O2 supply to the nodule plays a critical 

role in the regulation of nitrogenase activity. 

Installing and Running Logger Pro 3 

PC Users: 
 

(1) To start, a complete copy of Logger Pro 3 must be installed on the computer.  Before starting the 
installation, make sure that all USB cables are disconnected from the computer.  Failure to do so 
may cause an error in the installation of the USB drivers. 

(2) Run the installation and do not change the default destination directory.  Logger Pro 3 will be 
installed in C:/Program Files/Vernier Software/Logger Pro 3. 

(3) The setup process will automatically load the USB drivers for connecting the LabQuest mini or other 
interfaces to the computer. 

(4) If QuickTime 6 (or greater) is not installed on the computer, it is advised that it be installed when 
prompted.  QuickTime will allow the use of picture and movie features of Logger Pro 3. 

(5) You will be prompted to connect the LabQuest mini interfaces to the computer via the USB 
connection.  The LabQuest minis will be connected to the computer by connecting the USB1, USB2 
and USB3 cables (in that order) from the Q-Box frame into the computer (via the USB hub if 
necessary).   

(6) Click ‘Finish’ to complete the installation process. 

(7) Proceed to C404 installation (below) before opening the Logger Pro software with the “Q-Box NF1LP 
Setup” file. 

(8) Double click the “Q-Box NF1LP Setup” file (create a shortcut on the desktop once the file has been 
moved from the C404 disk) to start Logger Pro and data collection. If Logger Pro detects the 3 
interfaces, the Logger Pro screen will appear with three LabQuest Mini stars in the top left side 
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(9) If Logger Pro cannot detect the Interfaces a message will appear “no device connected” or only one 
icon will be visible.  Check first that the interfaces are connected to the computer via the three USB 
cables and connections 1, 2 and 3 on the frame of the Q-Box or via the USB Hub if necessary. The 
LED power lights on the minis should be green.  No LED light indicates no power is being supplied 
to the mini.  A red LED indicates that power is on but there is no communication between the mini 
interfaces and the computer.  In this case, exit the “Q-Box NF1LP Setup” file and unplug the USB 
cables from the computer.  Plug in the USB cables 1, 2 and 3 back into the computer (via USB hub 
if necessary) in that order. Allow the computer to apply the drivers for the interfaces and re-open 
the “Q-Box NF1LP Setup” file again. Alternatively, one can open the “Q-Box NF1LP Setup” file first, 
and then plug the 3 USB cables in the correct order one at a time and wit for the 3 stars to appear 
in the software as each interface is recognized.  Then proceed to connection of the sensors as 
described above. 

 

 
 

  
 

Macintosh Users: 

(1) To start, a complete copy of Logger Pro 3 must be installed on the computer (running at least OS 
9.2).  Run the “Complete Installation” and make sure that all TI GRAPH_LINK and USB cables are 
disconnected. The most recent version of Logger Pro (3) is included with this package. Following 
instructions are the same as for PC users. 
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C404 Custom Setup Files Installation: 

Qubit Systems’ C404 Custom Setup Files CD contains Qubit Experiment files designed by Qubit Systems 

for the package purchased, in this case “Q-Box NF1LP Setup”. The Experiment files contain the setup (i.e. 

graphs, table, calculations etc) for the various experiments, as well as the calibration constants for the 

Qubit sensors.  The C404 disk also contains a manual for this package and the LabQuest Mini data 

interface.  All Files from this disk files can be copied to user specified location on the computer and the 

experimental file of interest “Q-Box-NF1LP Setup” should be placed in an accessible location or have a 

shortcut created on the desktop to the file.  We highly recommend for the user to make a copy of the 

original file and keep it in a safe place on the computer in case the original is accidentally altered. 

 

Using the Q-S121 H2 Analyzer  

The H2 sensor of the Q-S121 H2 Analyzer is a semi-conductor device incorporating a heated alumina 
ceramic tube. O2 binds to the surface of the semi-conductor, and H2 that comes into contact with it 
combusts, causing the resistance of the semi conductor to change depending on the concentration of 
both the O2 and H2 present. The output of the H2 sensor is, therefore, dependent on both the H2 and O2 
concentrations of the gas that flows through it. The response to H2 concentration is non-linear, but the 
Logger Pro “Q-Box NF1LP Setup” file provided with the Q-Box NF1LP N2 Fixation Package incorporates a 
5th order polynomial function so that voltage readings from the sensor at O2 concentrations of 21% can 
be converted to H2 concentrations in ppm.  This polynomial function differs depending on the nature of 
the balance gas (N2 or Ar). Hence the user needs to manually indicate which background gas is being used 
(Air or Ar:O2 by depressing the C301 event switch in a correct position.  The output of the H2 Sensor is 
also affected by the O2 concentration; however the Q-Box NF1LP Package has been designed for use at 
O2 concentrations close to Air levels of 21%.  If the H2 Analyzer is to be used at O2 concentrations different 
from 21% a custom calibration of the analyzer needs to be performed at each of the O2 concentrations 
and the polynomial equation for each of the O2 concentrations needs to be incorporated into the 
software.  This is beyond the scope of this package. Contact Qubit Systems for information on the 
components required for custom calibration at different O2 levels.  

The H2 Sensor of the Q-S121 H2 analyzer requires heating to operate, therefore, it functions optimally 

when it is activated for several hours before use.  A warm up time of at least one hour with air flow past 

the analyzer is required and if the H2 Analyzer is to be used regularly over a period of time it is 

recommended to leave it powered up continuously.  The response time of the H2 Analyzer is greatly 

enhanced if the sensor is exposed to a high concentration of H2 (0.5 to 1% is ideal, but calibration gas of 

100ppm will also work well).  A brief exposure (2-5min) before daily use is recommended.  This can be 

done by filling a syringe with H2 gas of an appropriate concentration and injecting the gas into the inlet 

port of the sensor. 

The H2 sensor is also greatly affected by moisture so the gas supplied to the sensor needs to be well 

dried.  It is important to check the drying column before using the system and possibly using two in a 

series to ensure that gas entering the analyzer is dry 
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Using the Drying Column  

The Q-S121 and Q-S102 are designed to analyze dry gas samples.  Moisture in the gas can significantly 

affect the response of the H2 sensor so it is important to dry all gases delivered to the H2 analyzer (both 

from the nodulated pot and from a gas bag filled with calibration gas from a tank.  A desiccant column is 

provided which is filled with DRIERITE to dry the gas before analysis.  The column is supplied ready for 

use.  The column should be mounted vertically on the back of the analyzer with “wet” gas entering at the 

bottom and dry gas exiting from the top. 

DRIERITE contains an indicator that is blue when the column is functional and pink when the DRIERITE is 

spent.  When spent, the DRIERITE should be replaced or reconditioned.  To recondition, remove the 

DRIERITE from the column and place it in a drying oven at 210oC for 1 hour, or until the pink coloration 

disappears.  The replacement DRIERITE is #8 mesh, order #23005 from drierite.com.  

Magnesium Perchlorate is an alternative drying agent which is more effective than Drierite.   However, 

magnesium perchlorate will turn into liquid with time so it must be changed frequently.  It is 

recommended that a trap (2 PTFE filters are included in the Q-Box accessory kit for this application) is 

installed downstream if using magnesium perchlorate.  Qubit Systems is not responsible for any damage 

caused to any components of the Q-Box due to magnesium perchlorate entering any part of the system. 

 

Using the Q-S102 O2 Analyzer 

The Q-S102 O2 Analyzer contains an O2 sensor which is a galvanic cell (a lead-oxygen battery) consisting 

of a lead anode, an O2 cathode, and an acid electrolyte.  It also incorporates an O2-permeable Teflon FEP 

membrane with a gold electrode bonded to its surface.  Oxygen diffusing through this membrane is 

reduced electrochemically at the gold electrode.  A resistor and a thermistor (for temperature 

compensation during diffusion across the Teflon membrane) are connected between the anode and the 

cathode.  The output of the instrument is proportional to the current flowing through the resistor and 

thermistor.  This is, in turn, proportional to the partial pressure of O2 in contact with the Teflon FEP 

membrane.  The signal from the oxygen sensor is transmitted to the computer via the LabQuest mini 

interface (i.e. Q-S102 O2) and it is also displayed on the analyzer in kPa.  The Q-S102 O2 Analyzer has two 

analog signal outputs, one for O2 and one for total gas pressure at the O2 sensor.  The pressure readings 

from Q-S102 is recorded in software and is  used in correcting the O2 signal in KPa to O2 in % (O2 Pcor).   
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Because of changes in total gas pressure at the O2 sensor, the O2 (Pcor) reading in the software (corrected 

for pressure changes) may not be the same as the Q-S102 O2 reading. Only at a gas pressure of 100KPa 

will both the Q-S102 O2 (kPa)and the O2 (Pcor) (%) be the same. 

The galvanic cell is housed in a brass cylinder for greater temperature stability and more stable O2 signal. 

Pressure (Q-S102 P) is measured at the O2 cell and can be recorded in the software.  However in the NF1LP 

package, this pressure value is not recorded, rather a user parameter value of atmospheric pressure, 

Patm, is used to convert the partial pressure of O2 (Q-S102 O2 in kPa) to a concentration O2 (Pcor) in % 

which is independent of pressure.   

O2 (Pcor)=((Q-S102 O2)/(Patm))*100 

The pressure corrected concentration is displayed in a meter and a graph on Page 1 of the “Q-Box NF1LP 

Setup” file.  

The maximum flow rate through the Q-S102 O2 analyzer should not exceed 650 ml/min.  The minimum 

flow rate through the O2 analyzer should not drop below 5mL/min to avoid local depletion of O2 at the 

membrane of the sensor.  The analyzer should not be exposed to pressures that are +/- 5 PSIG or the 

damage to the sensor can result.   The expected life of the O2 Analyzer’s galvanic cell is 3 – 5 years.  If it 

is impossible to adjust the O2 analyzer’s signal amplitude by adjusting the gain, a new sensor must be 

installed.  Replacement of the sensor is simple.  Contact Qubit Systems to make arrangements to replace 

the galvanic cell of the analyzer.   

The Q-S102 is supplied with its own drying column filled with Drierite.  When used in a series with the Q-

S121 H2 Analyzer, only one drying column is necessary (in front of the Q-S121).  When using the Q-S102 

in a stand-alone mode, gas should be dried before entering the O2 Analyzer. Place the drying column in 

the bracket mounted on the back of the analyzer and connect it to the “in” port via the blue filter (25m). 

Check the filter frequently to ensure that it is not plugged.  Plugged filters will result in reduced gas flow 

to the analyzer and should be replaced. 
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Troubleshooting the Q-S102 O2 Analyzer 

If the O2 signal can no longer be adjusted with the “O2 Span” and the Analyzer has been used for 3-5 years 

the galvanic cell should be replaced.  Contact Qubit Systems for instructions on ordering the new cell and 

the replacement procedure. 

If significant periodic jumps (0.5-1%) in the O2 readings are observed, this may indicate pressure damage 

to the Teflon membrane inside the sensor cell.  If the signal shows unexpected drift, check for other 

damage to the membrane by removing the Q-S102 O2 Analyzer from the Q-Box tray (loosen screws on the 

back of the tray that hold the analyzer in place).  While monitoring the O2 readings, tilt the analyzer 90 

degrees.  If there is a large change in the signal following the tilt, the Teflon membrane is likely damaged.  

If no large change in signal is observed, then the drift may be associated with atmospheric pressure 

changes.  In case of any damage to the membrane, the galvanic cell should be replaced.  Contact Qubit 

Systems for replacement instructions.  In case of drift in the signal due to atmospheric pressure changes, 

base line (reference) measurements should be obtained more frequently. 

If small pulses in the O2 readings are observed when running a stable gas, this may indicate pressure 

changes in the system which may occur as a result of unstable gas delivery.   Check the system for any 

obstructions or restriction in the gas lines first and eliminate these.  Second check the O2 analyzer by 

unplugging the gas supply line from it and monitor the O2 readings.  The reading should become stable 

shortly after detachment of the gas supply line.  A stable reading when no gas is running past the analyzer 

indicates that the gas delivery to the analyzer is the problem and should be further investigated.   

 

Using C301 Event Switch (Air/Ar) 

The C301 event switch is connected to channel 2 of LabQuest Mini 1 and when the switch is in Air position 

zero voltage signal is recorded in Logger pro.   When background gas running through the system is 

changed to Ar:O2 mixture, the switch needs to be manually depressed in the Argon position with the red 

LED light on.  The signal recorded by the software and displayed in the Air/Ar switch meter is 1. 
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This change in event switch position is necessary for the software to correct the H2 signal for the 

background gas used since the output of the H2 analyzer is affected by the background gas.   

Also the flow rate of the Q-G268 and Q-G267 Flow Monitors is affected by the change from Air to Ar:O2 

mixture and this event switch is used to correct the gas flow rate through the pot and through the system.  

The meters and the graphs on page 1 of the software display corrected flow rates.  The corrections for 

both flow monitors have been calculated using mass flow controllers. The values for both the Q-G268 and 

Q-G267 should drop while the argon mixture is passing through them. The values shown are true 

representations of the flow rate that account for the difference in mass between argon and air. 

Logger Pro uses different coefficients in the 5th order polynomial which converts H2 voltage to H2 

concentration (ppm) for the different background gases.  If the user forgets to change the position of the 

event switch when the background gas is changed, the H2(cor) data will not be displayed correctly.  

Hence the Warning message in the software is shown to remind the user to make this change. 

 

In case the change of event switch position is forgotten, the correct data can still be obtained from the 

calculation columns of the raw data table in columns labeled H2(air), H2(Ar) as shown below: 
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The data in the H2(Air) column is H2 data calculated for Air as background gas and H2(Ar) column has H2 

data calculated for Ar:O2 mixture as the background gas.  When the data is exported File>Export as>CSV 

and then opened in a spreadsheet program such as Excel, these columns will be accessible. 

Using the S132 Temperature Probe   

The temperature sensor is a thermistor mounted on the end of a stainless steel probe.  It is nonlinear with 

an operational range from –40oC to +125oC.  The calibration for the temperature sensor is fixed in the 

Logger Pro software.  The temperature sensor should not require calibration, however this is possible in 

the Logger Pro software using the menu commands Experiment>Calibrate.  The sensor is recognized 

automatically and calibration is loaded when the “Q-Box NF1LP setup” file is opened.  The sensor is 

mounted on a stainless steel support, which fits through the temperature sensor ports in the flow through 

chamber, or it can be placed in the pot for measurements of root system temperature.  The temperature 

sensor port in the flow through chamber must be plugged with a solid white rubber stopper when the 

sensor is not in use. 

Using the G122 Gas Bags 

The 30 L gas bags are made from a gas-impermeable nylon-polyethylene laminate and are heat-sealed.  

Tygon tubing is attached to each bag by a luer-lock fitting.  The fitting on the other end of the tubing 

attaches directly to the fittings “PUMP IN” port of the Q-G268 Flow Monitor and Pump via the blue filter.  

These bags can be filled with air or another gas mixture as required by the experiments.  Bags should not 

be over-inflated as this can cause weakening of the seams and eventual leakage.  After use, the bags 

should be fully deflated, preferably by attachment to a vacuum-line.    

 

Troubleshooting Q-G268 and Q-G267 Flow Monitor and Pump 

The Q-G268 and Q-G267 Flow Monitor and Pump have been factory calibrated and should not require 

further calibration.  However, if with time the flow values appear to be erroneous, it may be that the 

“Flow Zero” has drifted.  To reset zero, adjust “Flow Zero” with no gas running through the system 

(disconnect the “pump gas out” from “flow gas in”) until a zero flow value is displayed in Logger Pro.  Be 

sure not to accidently adjust the “Flow Span”.  If “Flow Span” needs adjusting, a calibrated flow standard 

(mass flow controller) must be used to calibrate the “Flow Span”. Otherwise the flow monitor may be 

returned to Qubit for recalibration.  The speed of the pump should be adjusted using the two needle 

valves on the back, however the speed potentiometer adjustment on the front of the instrument is also 

available if the max flow rate with the needle valves fully open is not being reached. 
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Cultivation of Plants 
 

The Nitrogen Fixation package includes seeds (Soybean: Glycine max, cultivar Maple Arrow), and inoculum 

(Bradyrhizobium japonicum), which, if treated properly, will yield H2-evolving legume symbioses that are 

suitable for use in experiments 28 days after planting.  Grow the plants as follows: 

(1) Surface sterilize seeds in 5% bleach solution for 2 min and then rinse in running water for 10 min. 
(2) Sterilize pots in 10% bleach solution and rinse thoroughly. 
(3) Place 1/4”- grade gravel in the base of the pots sufficient to cover the drainage hole, and then fill 

the pots with a porous inorganic growth medium.  Grade 16 industrial quartz (silica sand) is ideal.  
Unimin Corp. (203-966-8880) is a U.S. supplier of industrial quartz but local suppliers are available.  
Note that soil cannot be used as it contains microorganisms that oxidize some, or all, of the H2 
released by the nodulated roots.  Also, growth material with a small pore size will create too much 
backpressure to allow gas flow through the pots during experiments.   

(4) Water the quartz and make 2 holes, 1/2“ deep, near the centre of the pots. 
(5) Place one seed in each hole together with a very small amount of peat inoculums (pinch).  Cover the 

hole and place the pot in a growth cabinet or greenhouse. 
(6) Soybeans will grow well in the greenhouse during the summer months, or in a growth cabinet with 

a 16 h photoperiod at a constant 20oC.  Use as high a light intensity as available in the growth 
chamber to promote growth. 

(7) Flush the pots twice daily with a nitrogen-free nutrient solution.  It is essential that the plants are 
not exposed to even moderately high levels of nitrogen, since this will inhibit the nitrogenase that 
is present and prevent further expression of the nitrogenase enzyme.  An ideal nutrient solution for 
legumes is composed of the following components per litre of solution: 
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(a) 257 µmol KH2PO4 

(b) 57 µmol K2HPO4 

(c) 502 µmol K2SO4 

(d) 243 µmol MgSO4 * 7H2O 

(e) 246 µmol MgCl2 * 6H2O 

(f) 748 µmol CaCl2 * 2H2O 

(g) 10 µmol MnSO4 * H2O 

(h) 1.0 µmol CuSO4 * 5H2O 

(i) 1.0 µmol ZnSO4 * 7H2O    

(j) 31 µmol H3BO3                   

(k) 0.5 µmol Na2MoO4 * 2H2O  

(l) 0.2 µmol CoSO4 * 6.5H2O 

(m) 38 µmol Fe from Fe- Sequestrine 
 

 Adjust final solution to pH 6.8 with acid or base as required.   

Each of these nutrient components may be made up as 2000-fold concentrated stock solutions 

(see following page for details) and may be stored in the following combinations: 

   (a) plus (b), (c) alone, (d) plus (e), (f) alone, (g) to (l) combined, (m) alone 

 Any other combinations of stock solutions may cause precipitation of solutes, and nutrient 

deficiencies.  During the first 10 days after planting, it is beneficial to supplement the nutrient 

solution with KNO3 to a final concentration of 0.5 mM.  This will stimulate nodulation and enhance 

N2 fixation capacity.  However, this treatment should be stopped when the plants begin to fix N2.   

(8) When the seedlings germinate, remove one seedling from each pot and dispose of it.  Leave the 
seedling that is most centrally located, in the pot. 

(9) Plants are ideal for experiments after 28 days, although older plants will produce greater amounts 
of H2. 

(10) After harvesting the plants, sterilize the pots in 10% bleach solution, and store for re-use. 
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Stock Nutrient Solutions for Legumes 
The following solutions represent 2000-fold concentrations of the working solutions: 

1 0.514 M KH2PO4 (69.90 g/L) 

2 0.114 M  K2HPO4 (19.84 g/L) 

3 1.004 M K2SO4 (174.70 g/L) 

4 0.486 M MgSO4 * 7H2O (119.70 g/L) 

5 0.492 M MgCl2 * 6H20 (100.00 g/L) 

6 1.496 M CaCl2 * H2O (219.80 g/L) 

7 0.020 M MnSO4 * H2O (3.38 g/L) 

8 0.002 M CuSO4 * 5H2O (0.50 g/L) 

9 0.002 M ZnSO4 * 7H2O (0.55 g/L) 

10 0.062 M H3BO3 (3.83 g/L) 

11 0.001 M Na2MoO4 * 2H2O (0.24 g/L) 

12 0.0004 M CoSO4 * 6.5H2O (0.11 g/L) 

13 0.076 M Fe from Fe Sequestrine See packet for Fe content 

 
Add 0.5 mL of each per litre of the working strength solution.  Adjust final pH to 6.8 acid or base as needed. 
 

Solutions may be stored in the following combinations: 

(1) plus (2), (3) alone, (4) plus (5), (6) alone, (7) to (12) combined, (13) alone 
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Specifications of Q-S102 O2 Analyzer: 

• Operating principle  - Acid Electrolyte, Teflon Diffusion Membrane 

• Detection Range - 0-25% and 0-100 %O2 (Linear) 

• Resolution - ±50 ppm  

• Accuracy ± 0.21% of Full Scale 

• Response Time (90%) - 12 Seconds 

• Life Expectancy of sensor - 3-5 years  

• Sensor easily replaceable  

• Influence by Other Gases - Ammonia and Ozone 

• min flow - 5 mL/min 

• max flow - 650 mL/min 

• Built in total gas pressure reading at the sensor (for pressure correction in the software) 

• Pressure Range - 0.5 atm to 1.5 atm 

• Pressure Effect - Output voltage changes proportionally  

• Shock Resistant - to 2.7 G 

• Avoid strong vibration 

• Operating Temperature - 5 to 40oC (Effective range) 

• Passive temperature control of the O2 sensor 

• Weight – 1.35 kg 

• Dimensions (cm) – (H x W x D: 5.5 to 9.5 x 9.5 x 17) 

• Output - 0 to 5 volt 

• Power Supply - 12 Volts 

• warranty: 1 year 

 

Specifications of Q-S121 H2 Sensor 

• Operating Principle: Tin-dioxide semi-conductor sensing element 
• Range: 0 to 100 ppm H2 (higher range in customized units) 
• Output: 0 to 5 V  analog to digital interface 
• Output sensitive to O2 concentration and background gas 
• Calibration at 21% O2 in N2 and Ar is provided with the H2 Analyzer 
• Sensitive to organic solvents and CO 
• Response time (90%) – 20 sec 
• Resolution – 0.001ppm 
• Long life expectancy of the sensor 
• Dimensions (cm) – (H x W x D: 5.5 to 9.5 x 9.5 x 17) 
• Weight – 0.85 kg 
• Operating Temperature - 5 to 40oC 
• Power supply – 12 Volts 
•  warranty: 1 year 

  



38 
 

Qubit Systems Warranty Information 

QUBIT warrants all its instruments to be free from defects in materials or workmanship for a period of 

one year from the date of invoice/shipment from QUBIT.  

If at any time within this warranty period the instrument does not function as warranted, return it and 

QUBIT will repair or replace it at no charge. The customer is responsible for shipping and insurance charges 

(for the full product value) to QUBIT.  QUBIT is responsible for shipping and insurance on return of the 

instrument to the customer.     

No warranty will apply to any instrument that has been (i) modified, altered, or repaired by persons 

unauthorized by QUBIT; (ii) subjected to misuse, negligence, or accident; (iii) connected, installed, 

adjusted, or used otherwise than in accordance with the instructions supplied by QUBIT.   

The warranty is return-to-base only, and does not include on-site repair charges such as labour, travel, or 

other expenses associated with the repair or installation of replacement parts at the customer’s site.  

QUBIT repairs or replaces the faulty instruments as quickly as possible; maximum time is one month.  

QUBIT will keep spare parts or their adequate substitutes for a period of at least five years.  

Returned instruments must be packaged sufficiently so as not to assume any transit damage. If damage 

is caused due to insufficient packaging, the instrument will be treated as an out-of-warranty repair and 

charged as such.  

QUBIT also offers out-of-warranty repairs. These are usually returned to the customer on a cash-on-

delivery basis.   

Wear & Tear Items are excluded from this warranty. The term Wear & Tear denotes the damage that 

naturally and inevitably occurs as a result of normal use or aging even when an item is used competently 

and with care and proper maintenance. 

Return Procedure 

Before returning any instrument to QUBIT:   

Consult the operating manual or contact Qubit to ensure that the instrument(s) is in fact faulty and has 

not just been set up improperly.  

Contact QUBIT before sending anything back.  We will issue an RMA number and provide shipping 

instructions.   QUBIT will refuse any goods that are returned without an RMA number or which are sent 

in a manner outside of QUBIT’S  stipulations. 

If you have encountered a program failure, we would need a printed copy of any faults you have seen, 

including how to reproduce them.  Include these in the return package along with your mailing address.  

Include a copy of the Invoice on which the product was shipped to you.  
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All returns must be shipped prepaid.  Unpaid packages will not be accepted.  

In case of questions contact QUBIT by  

E-mail: info@qubitsystems.com, 

 by phone: (01)-613 384 1977,  

or by fax: (01)-613 384- 9118. 

 

mailto:info@qubitsystems.com

